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Chapter 1 

MicroStation Tips and Tricks 

By Jose Aguilar 

 

According to ‘MicroStation TODAY’, customizing the workspace helps users comply 

with standards and increase production speeds.  A workspace is the MicroStation 

environment that you are working in, similar to your desk, it should have tools that you 

use frequently, easily accessible.  These environments are personal preference and 

should vary on the type of work being produced.   It helps reduce errors created by 

using the wrong resources to complete the project and also saves on redundant mouse 

clicks.  MnDOT has an office that provides support to users of MicroStation, Geopak 

and Projectwise.  The CAES office or Computer Aided Engineering Services office 

provides training, resources and data standards. They also provide ‘Tech Sheets’ for 

Microstation and Geopak.  

 

These sheets can be found externally at: 

http://www.dot.state.mn.us/caes/tech.html 

 

A more comprehensive selection of Tech Sheets can be found internally in Projectwise: 

TechSheets 

 

 

 

 

 

 

http://www.dot.state.mn.us/caes/tech.html
pw://pw8i.ad.dot.state.mn.us:cadp/Documents/TechSheets/
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Editing the Function Key Menu 

 

Function Keys are assigned commands created by the user for specific tasks. Under the 

function keys dialog box a user can setup specific actions for the available function 

keys. Once created the user can select the desired function key and quickly perform the 

wanted task. The intention is reduce the number of mouse clicks and quickly access 

certain commands of frequent use. 

 

1. In MicroStation, from the Workspace menu, choose Function Keys. The Function 

Keys dialog box will open. 
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2. Select a function key from the list box showing Key & Action or in the Function 

Keys group box, toggle any combination of the Ctrl, Alt, and/or shift and choose 

the desired function key from the 

list box or using the keyboard, 

press the desired function key 

and the <Ctrl>, <Alt>, and/or 

<shift> keys. 

 

3. In the Action text box, edit 

the definition or add an 

action. It must be a valid 

MicroStation key in.  As a 

check, use the Key-in tool 

to verify the command. 

4. Click OK when you’ve edited or created the function keys you need.  Once these 

are created they are configured into your user preferences.  They can be edited. 

 

Note: Additional information can be found on the Custom Workspace Tech Sheet: 

Coordinate System Favorites, Function Key Menu, Creating your personal default 

button menu, editing the button menu, custom tools V* to V8I overview. 
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Aerial Photo and Raster Attachments 

 

 Often projects benefit or are required to overlay an aerial image. The preferred 

method for accessing aerial imagery is through the Web Mapping Service directory 

(WMS).  The files cover large areas and are georeferenced.  The CAES office provides 

a Tech Sheet for the WMS and Raster Photo Workflow.  It can be located within the 

MicroStation folder in Projectwise (or see Appendix B). 

 

Attaching a raster map based on the position information (TFW) of the image 

 

 A raster image with positioning information allows the image to display relatively 

close to its true location. These files contain a world file (TFW) comprised of data 

containing the file’s position and orientation.  A raster map alone is just an image with 

no known location or orientation but the world file positions the image to display 

correctly. The following steps will show how to attach a raster map with a world file in 

MicroStation.  

1. Download the TIF and TFW files from 

Right of Way Mapping & Monitoring for 

the map you want using the “Link Tool”. 

 

2. Bring both files into the same working 

folder in ProjectWise. The TFW and the 

TIF files must be stored in the same 

folder. 

 

3. Open your working CAD file and select the 

appropriate county coordinates (if not 

already set) using the tool “Geographic 

Coordinate System”.  

o Found under Tools – Geographic – 

Select Geographic Coordinate 

System 

o Using the From Library icon - Favorites – Minnesota Counties Survey Foot  

         

4. In Raster Manager attach the raster image. Do not attempt to include the TFW file as 

an attachment, it will not load (it is not a raster image).  

o When the pop-up dialog box displays be sure to turn off Place Interactively. 
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o The raster image will not display over any existing CAD work because its 

coordinate system has not been selected. 

 

 

5. To adjust the image to its correct viewing location set the image’s coordinate system 

to UTM83-15F (UTM83-14F depending on location). Right-click on the image and 

select the coordinate system.  

 

 

 

 

  

 

 

 

The raster image should now display 

overlapping the corresponding CAD 

file.  

 

  Example map 4-41 

 

Note: CAD and Raster images may 

never align perfectly   
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Warping Raster Images 

 

The Warp Raster tool allows you to apply a move, scale, rotate or skew transformation 

or a combination of all of those to a Raster image. 

1. Setting up your raster image for warping 

 

First, determine how the raster file was brought into MicroStation. A raster 

without a TFW file (world file) can be altered using the warp tool to overlay 

existing CAD work. A raster with a TFW may require additional steps if it 

was brought into MicroStation from Right Way Mapping & Monitoring. See 

Raster Images with TFW below for steps on deleting the coordinate 

system and moving the raster image.  

 

2. When warping a raster image it is best to have something to warp the image to, 

such as CAD work.  The following steps assume that a CAD file has been 

created and that raster image is very close to overlaying the existing work area. 

 

3. In Raster manager there is a tool called Warp. 

 

4. Identify the points that can be used for the transformation.  Locate corners or 

intersection points found on both the CAD file and raster image 

 

5. Select a desired method.  The warp tool offers multiple options to manipulate a 

raster image.  With this tool you can move, rotate and resize an image.   

 

Warp Raster Methods 

 

Align (Move, Scale) — Two 

points (only) are required and 

scaling is uniform along the x- 

and y-axes 

Helmert — Two points (only) are required 
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Similitude (Move, Scale, Rotate) — Requires a minimum of two points. When two 

points are entered, a best fit is produced from the points. If more than two points 

are entered, then the source and destination points may not line up. 

Affine (Move, Scale, Rotate, Skew) — Requires a minimum of three points and 

then produces a best fit. If more than three points are entered, the source and 

destination points may not line up. 

(definitions from MicroStation Help V8i) 

Terms:  

Enter Image Point – refers to a point on the raster image you want to use to warp  

Enter Monument Point – refers to the CAD point to which you want the raster 

 point to move to.  

6. Click on the appropriate image and monument point.  The command line will 

indicate what needs to be selected. The command line is found on the lower left 

side of the screen.  
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Each image shows an image point (raster image) being moved to a monument point 

(CAD) using Affine-3 points 

7. Continue with additional points as necessary depending on the method selected.  

Once complete, the raster image should overlap the existing CAD work.  It is 

important to note that CAD and raster images may never align perfectly. 

 

 

The raster image aligns better 

with existing CAD lines after 

warping 
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Free a Raster Image from its World File (TFW) 

 Maps downloaded from Right of Way Mapping and Monitoring with a TFW file 

are referenced to the UTM Geographic Coordinate System.  If the raster image needs to 

be manipulated, then the associated coordinate system needs to be removed.  This 

allows the file to be manipulated and better fit the existing line work.  Deleting the 

coordinate system will result in the raster image appearing distant from the work area.  

If you are having trouble finding the image try using the ‘Fit Rasters to View’ tool. 

  

1. To retain the general location of the 

file, set a box or line to which the 

raster can be moved back to. 

 

Example of using a line 

 

 

 

 

 

2. Next proceed with removing the UTM Coordinate System by right-clicking on the 

raster name –Coordinate System and selecting Delete. The raster file will 

appear distant from the working area. 
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Example of a raster image far from the 

working area 

 

3. Manually move the raster file using the 

same location and orientation as the 

previously created box or line.  This 

step returns the file back into the work 

and appears very close in orientation 

to how it was prior to deleting the 

coordinate system. 

 

4. Once the file is returned to the work area it can be warped to fit the existing CAD 

work.  (Refer to Steps for Warping Raster Images) 

 

Scaling a Raster Image (Files without a TFW file) 

The following table shows how a raster map without a world file can be manually set to 

scale.  

Map Scale Pixel Size (400 dpi) Pixel Size (200 dpi) 

1:50  0.125   0.25 

1:100  0.25   0.50 

1:200  0.50   1.00 

 

Note: 400 dpi raster maps will typically display long portions of a map with individual 

sheets ending at match lines were as the 200 dpi maps display short, often standard 

length portions of a map containing numerous map sheets and each sheet ending at a 

random location.  

 



13 
 

If the scale of the map is unknown, then one 

could guess.  Verify the correct scale measure 

between tick marks or any labeled distance using the 

Measure tool. The raster image distance should be 

very close to the CAD distance.  

 

This example shows the pixel size at 0.25 for a 

400 dpi file 

 

 

Line Style Annotation Fixer 

Software enhancements and updates to the custom line styles resource file were 

performed to accommodate for Annotation scale. A new seed file was created by the 

CAES Office to scale line styles at a Drawing Scale of 1:100 (back in 2013). Older files 

containing custom line styles will appear out of scale because of how they were 

originally placed. This will often occur when working with older files imported into a new 

seed file.  

The following are a set of steps to identify if your file is having this problem.  

 Obtain a copy of a new seed 

file  

 

 

 Reference the old file into the 

new seed file. 

 

 

 

 Merge your old file into the new seed file. 

 If the line styles or text display out of scale 

 then the fix will need to be performed on the 

 file. If  the line styles are displaying correctly 

 then no further action is required.  
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Prior to performing the fix, the access 

control symbols are not visible at this scale. 

 

 

 To update the DGN to use annotation 

scale for imported line styles use 

LineStyleScaleAnno.  This will scale the 

line styles to view correctly. 

 

 

 

This image shows the access control 

displaying to scale after using the fix. 

 

Another method that may provide some clues as to whether the lines will scale correctly 

is by identifying the type of Line Style Scale set for the DGN model. This can be found 

within Model 

Properties.  

 A new seed file 

displays 

Annotation 

Scale, 1=100 

 An Old seed 

files displays 

Global Line 

Style Scale, 

Full Size 1=1 
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Terms 

Annotation Scale – Scale factor of the drawing, drives the scale of the elements 

depending on the Drawing Scale selection.  

See the Tech Sheet MS_CADDStandardsUpdate for additional information regarding 

level libraries, text and dimension styles, custom line styles, seed files, cell libraries, 

GEOPAK 

Using Google Earth in MicroStation 

Overview 
 

MicroStation has the ability to interface with Google Earth.  It requires no additional 

CAD software.  Google Earth must be loaded, either the free or professional version. 

MnDOT can utilize the free Google Earth software for internal use only!  If you have any questions, see 
your district / office IT staff. 

The basic steps are: 

1. Open MicroStation file from within ProjectWise and assign a county coordinate 
system.  Set levels on / off as you want to view them in Google Earth. 

2. Create a KML/KMZ file, which automatically opens Google if installed to the correct 
location. 

3. View as desired. 

4. Export image (optional). 

MicroStation File Setup and Creation 

Open the MicroStation file either 2D or 3D from within ProjectWise and perform the 

following steps as needed: 

1. Assign the coordinate system for the file.  

Use the Geographic Coordinate System dialog found under Tools 
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Click on ‘Select Geographic Coordinate System’ and then the ‘from library’ button 
and select the appropriate coordinate system from the library. The CAES office 
provides a Tech Sheet on how to do this: MS_AssignCoordinateSystems.doc .  

 

2. Turn off the weights, which are normally too heavy within Google Earth. 

3. Turn off any levels that are not needed, in order to have the most basic drawing as 
possible that will fulfill your project requirements. 

4. Set your view to the area of interest.  Keep in mind the larger the area, the fuzzier 
Google Earth is when you zoom in. 

5. Select Tools > Geographic > Export 
Google Earth (KML) File from the 
main MicroStation menu. 

pw://pw8i.ad.dot.state.mn.us:cadp/Documents/TechSheets/MicroStation/MS_AssignCoordinateSystems.doc
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6. A ProjectWise dialog opens where you can name the Google Earth file.  Note that 
it’s creating a KMZ file, not KML as seen in the tool tip.  If you have not created a 
KMZ file from this MicroStation file, you can use the default name.  Otherwise, 
change the name in order to save it in ProjectWise.  

Note: KML is an uncompressed Google Earth file – KMZ is a compressed Google 
Earth file  

7. Click Save. 

Synchronizing With Google Earth 

Open the file with Google Earth, if it has not done so automatically.  You will see 
the Google Earth background, with the MicroStation drawing on top.   
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Chapter 2 

Azimuths and Bearings 

By Josh DeLeeuw 

 

One of the first practical guides for the field surveyor was, GEOSAESIA, written by John 

Love with the first edition published in 1687.  Thirteen editions of the book were 

published and many notable Colonial surveyors studied it, including George 

Washington.  

 

In this book, Love defines a point, line and 

angle: 

“A point is that which has not parts; 

consequently of itself no magnitude, and 

may be considered as invisible.”  

“A line has only length, but neither breadth 

or thickness, and may be conceived as 

generated by the continual motion of a 

point.” 

“An angle is the meeting of two lines in a 

point.” 

 

The most common unit for measuring an angle is with the Sexagesimal System of 

dividing a circle into 360 degrees with each degree measured by 60 minutes and each 

minute measured by 60 seconds.  Common surveying practices used a compass to 

navigate and measure horizontal angles to determine the location and orientation of 

points.  One of the early instruments was a circumferentor.   

 

This instrument is a compass with sights.  The 

reference meridian would be magnetic north.  

To measure an angle between two known 

lines, one would set the instrument over the 

point of intersection.  Then sight to one known 

point, note the degree pointed at by the south 

end of the needle, then turn the instrument to 

a point on the other line.  The angle would be 

found by calculating the difference.  
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This same concept is used today.  There are two styles of annotating the direction of a 

line; either by azimuth or by bearing. 

What is an Azimuth? 

 Definition: Horizontal angle observed clockwise from any reference       

      meridian. (Elementary Surveying 12th Edition p. 168) 

The angle measured clockwise from the meridian (usually from a north or 

south reference line) to the line being described. (Brown’s Boundary Control 

and Legal Principles) 

o Generally 0° is Grid North, also known as the zero base line.  Grid 

North is dependent upon which datum you are using.   

 

 

 The azimuth is MnDOT’s standard 

method for identifying the direction of 

a line.  For Right of Way Acquisition 

Plats, the course and direction are 

located in a boundary tabulation box. 

 Azimuths allow for simpler 

computations.  You are able to 

determine the angular relationship 

between the two lines by subtraction. 

Example:  Line 1az = 

180°  Line 2az =   90° 

           180° - 90° = 90° ~ angular relationship 
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 Examples of azimuths and computing the angle between them. 

 

az = 54°00’00”     az = 345°00’00” 

 

 

 

 

 

 

 

 

 

az = 231° 00’00” 

     az = 112°00’00” 

 

What is a Bearing? 

 Definition:  The acute horizontal angle between a reference meridian and 

the line. (Elementary Surveying 12th Edition p. 169) 

o The reference meridian is 

usually the north-south line 

that divides the quadrants of a 

circle. 

 

o Quadrant bearings are not 

generally used on MnDOT 

mapping or Acquisition Plats.  

Although Minnesota State 

Statute 505.021 allows for the 
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use of azimuths or bearings on plats; bearings are more common.  

(https://www.revisor.mn.gov/statutes/?id=505.021) 

o Quadrant bearings allow for directional qualifiers so that the reader of 

a legal description or plat will know what direction the line is headed 

based on 90° as opposed to an azimuth that gives a direction based 

on 360°.  The azimuth requires the readers to know which quadrant 

they are in to determine the direction of a given line.  

o Angular relationships can be figured out, but some simple steps need 

to be followed to ensure the proper calculation of an angle between 

two bearings. 

o Examples of computing an angle between bearings 

 

 

 

 

 

 

 

https://www.revisor.mn.gov/statutes/?id=505.021
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How do they relate to each other? 

 They are both based upon a definition of north. 

 Azimuths utilize a full 360° circle.  The directions are based off of north, 

being 0° and considered the base line or reference.  Measurements are 

made clockwise from the base line. 

 Bearings are limited to on one fourth of a circle or 90°.  They are based off 

of 0° being north and 0° being south.   

o They are measured as follows: 

i. East of North (NE quadrant) 

ii. East of South (SE quadrant) 

iii. West of South (SW quadrant) 

iv. West of North (NW quadrant) 

 

 Converting from azimuth to bearing 
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 Converting from bearing to azimuth 
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How to relate a Subdivision Plat to the .fip file or MnDOT Survey Information 

 Find a common section line and compare the azimuth in the .fip file to the 

bearing on the subdivision plat.  

 Compare the .fip file 

direction and the plat 

direction for the 

common line. 

o If they are not 

the same, 

calculate the 

difference. All 

the subsequent 

lines on the 

plat can be 

adjusted by the 

found 

difference. 

o For example:  

MnDOT .fip file 

azimuth for the west line of Government Lot 2 is 179°40’52” 

i. Bearing to Azimuth:  180° - 00°39’28” = 179°20’32 

ii. .fip – plat:  179°40’52” - 179°20’32” = 00°20’20” 

iii. Adjust or rotate the north line of the south 539.00 feet, 

S88°51’57”E - 00°20’20” = S88°31’37”E 

180° - 88°31’37” = az 91°28’23” 

 Another method is to compute each angle between the given lines on the 

subdivision plat and use that angle when entering the data into the .fip file. 

o For example the angular difference between the west line of 

Government Lot 2 and the north line of the south 539.00 feet is: 

S88°51’57”E – S00°39’28”E = 88°31’37” 

i. Subtract the difference from the .fip file: 

az 179°40’52” - 88°31’37” =  az 91°28’23” 

 The subdivision plat may not match the .fip file.  This may be due to 

accuracy differences and data collection techniques.  Different coordinate 

systems may also be the source of differences in measurements.  There is 

software available to compare coordinate systems:  

http://www.dot.state.mn.us/surveying/toolstech/survsoft.html 

  Contact Cory Arlt for assistance:  corwyn.arlt@state.mn.us 

http://www.dot.state.mn.us/surveying/toolstech/survsoft.html
mailto:corwyn.arlt@state.mn.us
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Converting to decimal degrees 

 Converting degrees minutes and seconds to decimal degrees may simplify 

your computations.  Similar to the measure of time, an hour is divided into 

60 minutes; a degree is also divided into 60 minutes.  The same concept is 

applied to seconds.  1 minute is 60 seconds; multiply that by 60 for 60 

degrees and the result is 3600 seconds in a degree.  

For example we will use 54°33’27” 

Degrees = 54 

Divide minutes by 60:  33/60 = 55 

Divide seconds by 3600:  27/3600 = 75 

The decimal degree = 54.5575° 

 To convert decimal degrees to degrees minutes seconds, simply do the 

above procedure in reverse: 

Multiply .0075 by 3600: .0075x3600=27 

Multiply .55 by 60:  .55x60=33 

The Degree Minutes and Seconds = 54°33’27” 

How to use the scientific calculator to add or subtract azimuths and bearings 

 This procedure is by using the calculator in Windows 7 

 

 

 

 

 

 

 Switch to scientific mode under the view menu. 

 Type in the degrees minutes seconds of the 

first line.  

o For example:  180°30’00” 

Enter it as 180.3000.  This calculator does 

not think in degrees minutes seconds 
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o decimal degrees are units of 1/10/100 

o degrees minutes seconds are in units of 1° = 60’ = 3600” 

 

 Press the key  

 

 Press the   

 

 

 

 

 

 To subtract angles, press the – key and enter the value of the next line.  We will 

use 54°33’27”.  Again, type 54.3327 => inv key => deg ke 

 If you want that in degrees minutes seconds format, select the inv key and then 

the dms key 
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Practice Problems: 

1. Convert Degrees Minutes Seconds to Decimal Degrees 

a. 11°25’33” 

 

2. Convert Decimal Degrees to Degrees Minutes Seconds 

a. 245.7650° 

 

3. Convert from azimuth to bearing 

a. 127°25’37” 

b. 345°13’26” 

c. 138°59’01” 

d. 26°01’33” 

 

4. Convert from bearing to azimuth 

a. N15°27’02”E 

b. S56°13’59”E 

c. S79°58’16”W 

d. N86°01’56”W 

 

5. Compute interior angles 

a. Az1= 349°25’13” Az2=2°01’47” 

b. Az1= 156°55’00” Az2 = 149°04’47” 

c. N89°05’56”E  S54°01’45”E 

d. N45°12’50”W  N54°21’05”E 
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Practice Problems (Answers) 

1. Convert Degrees Minutes Seconds to Decimal Degrees 

a. Convert 11°25’33” to Decimal Degrees  

a. 11.4258 

b. Convert 245.7650 to Degrees, Minutes, Seconds 

a. 245°45’54” 

2. Azimuth to Bearing Conversions 

a. Convert the azimuth 127°25’37” to a bearing 

a. S52°34’23”E 

b. Convert the azimuth 345°13’26” to a bearing 

a. N14°46’34”W 

c. Convert the azimuth 138°59’01” to a bearing 

a. S41°00’59”E 

d. Convert the azimuth 26°01’33” to a bearing 

a. N26°01’33”E 

3. Bearing to Azimuth Conversions 

a. Convert the bearing N15°27’02”E to an azimuth 

a. 15°27’02” 

b. Convert the bearing S56°13’59”E to an azimuth 

a. 123°46’01” 

c. Convert the bearing S79°58’16”W to an azimuth 

a. 259°58’16” 

d. Convert the bearing N86°01’56”W to an azimuth 

a. 273°58’04” 

4. Computing Angles 

a. What is the smaller angle between the azimuths 349°25’13” and 

2°01’47” 

a. 12°36’34” 

b. What is the smaller angle between the azimuths 156°55’00” and 

149°04’47” 

a. 7°50’13” 
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Chapter 3 

Computations in Geopak 

By Josh DeLeeuw 

 

GEOPAK CUSTOMIZATION  

 When using GEOPAK it is important to make it familiar each time it’s used.  By 

customizing the tool bar with the tools used most often the user can become much more 

efficient.  There are several tools that can be used to create points, lines, curves, 

chains, etc.  It’s up to the user to decide which tools he/she will put on their toolbar.  To 

customize the toolbar use the following steps: 

1. Select Customize This Group from the View/Icons menu. 

 
 

2. Select the tools to be displayed on the toolbar and then click OK. 
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TOOLS USED MOST WHEN COMPUTING 

 

1. Locate Traverse   (Points)  

 

 

2. Intersect Tool (Points) 

 

 

 

3. Store Curve By End Point (Curves) 

 

 

4. Store Curve By Tangents (Curves) 

 These are the four commonly used and basic tools for computing.  The following 

pages will take the user through some of the basic functions of each.  Please keep in 

mind that there are several different ways for the user to create points, lines, curves, 

etc.  The use of these four computation tools will give the user the basic understanding 

of how a point, line, curve, etc. is created thus giving the user the background to use the 

many other tools available in geopak. 

LOCATE TRAVERSE TOOL 

 
 This tool allows the user to create points by means of a virtual traverse.  The 

default dialog box calculates the slope distance; be sure to change the Slope Distance 
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to Distance using the drop down menu.  This will eliminate the possibility of adding an 

elevation to points that is unnecessary for the computing that is done in right of way.  By 

leaving the slope distance on, the user runs the risk of accidentally changing the zenith 

angle which would result in a computation of a slope distance rather than the grid 

(horizontal) distance.   

 

The Locate Traverse tool is ideal for the following: 

 Set a point on a line between two known points.  

 Set a point at a specific offset distance between two points. 

 Set a point on deflection angle from a line between two known points.  

Commonly this would be called for in a property description or shown on a 

subdivision plat.  

 Set a point from a known point using a distance and direction.   

 The following steps will show how to perform each of these four functions using 

the Locate Traverse Tool.  Remember to visualize the points to be used for 

computations before using this tool.  It will make the computing process easier and 

minimize data entry errors.  It is strongly suggested to make sure the Redefine box is 

not checked on.  This will eliminate the chance that the user would overwrite a 

previously stored point/element. 

 Set a point on a line between two known points 

 

1. Type in the point you wish to store first in the Locate Point Box.  Metro 

numbering standards ask the user to type their initials in followed by a number, 
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for example JD3001.  (Ask the District Surveyor for the appropriate naming 

convention used, or see Appendix A for metro’s) 

 

 

2. Click inside the Station Name box to move the 

cursor there.  Then select the point you wish to 

calculate a new point from by clicking on the 

visualized point in your MicroStation file.   

 

3. Then select the Direction you would like to use.  For setting a 

point between two known points, the Pa to Pb is the best 

option.  When using the Pa to Pb option, simply click inside 

the box on the left to move the cursor into that box, this is Pa, 

then click the visualized point you wish to be Pa.  After this 

point is selected the cursor will move to the Pb box and you 

will do the same to select that point.  Keep in mind which point 

you selected to be ‘a’ and which point you selected to be ‘b’.  It 

matters significantly in most cases because the direction of the 

line is important.  The direction of the line will be from Pa to Pb. 

 

4. Click inside the Distance box (not slope distance).  Enter in the distance you 

wish to set the point at and click ok.  This will store your point at a specified 

distance from the point the user determined to be ‘a’ on a line to the point the 

user determined to be ‘b’. 

 

 Set a point at a specific offset distance between two points 

 

1. Perform this process just the same as you would set a point on a line between two 

points.  The only difference is that you will need to add a few extra pieces of 

information to the tool. 

2. Determine the point number you wish to store, the point to start from and the 

direction.  (Pa and Pb)  Refer to the Plat Computations Standards when deciding 

the name. 

3. Check the Offset Distance box and type in 

the distance you wish to be offset from the 

line Pa to Pb.  Remember that if you wish to 

be on the left side of the line your value must be negative and if you wish to be on 

the right side of the line your value must be positive. 
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4. Type in the distance in the distance box that you wish to travel from your starting 

point along the Pa to Pb line and then click ok.  This will compute a point at a 

specified offset distance from a line at a specified distance along that line. 

 

 Set a point on a deflection angle from a line between two known points 

 

1. Perform this process just the same as you would set a point on a line between 

two points.  The only difference is that you will need to add one extra piece of 

information to the tool, a deflection angle. 

 

2. Determine the point number you wish to store, the point to start from and the 

direction.  (Pa and Pb)  Refer to the Plat Computations Standards when 

deciding the name. 

 

 

3. Click on the deflection angle box and specify if it will be a 

right (+) or a left (-) deflection. 

 

4. Type in the angle you will be deflecting in the following syntax DDD MM SS.  

Example, 180 00 00 or 95 27 35.  In some cases you may need to figure out the 

angle between two lines.  Please refer to the chapter on Azimuths and Bearings 

if needed. 

 

 

5. Type in the distance desired and click ok.  This will compute a point on a 

deflection angle between two different lines.  In most cases the starting point will 

be Pb, but again this will be dependent upon the type of computation the user is 

wishing to perform. 

 

 Set a point from a known point using a distance and direction 

 

1. Determine the point number you wish to store and the point to start from.  Refer 

to the Plat Computations Standards when deciding this name. 

 

2. Specify the direction type you wish to use.  Example Azimuth or Bearings and 

use the proper syntax for entering an angle, as shown above, to enter the 

desired direction.  

 

3. Specify the distance needed and click ok.  This will compute a point from a 

known point at a specified direction and distance. 
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INTERSECT TOOL 

The intersect tool is used when the user needs to determine the intersection 

between two elements.  An element can be defined in several different ways.  It could 

be an intersection of two lines (Bearing-Bearing) or a distance from two points 

(Distance-Distance).  Several types of intersections are illustrated below. 

 

A few variations of how to compute 

some of the most basic intersections shown 

above are described on the following pages 

and should supply enough knowledge of the 

intersection tool to use it in many different 

ways. 

 Basic Intersection between two lines 

using four known points (bearing-

bearing) 

 

1. Open the intersection tool and type in 

the point number you wish to store in 

the Locate Point Box.  Make sure Point 

to Point is selected in the element drop 

down boxes. 
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2. In the with Element area click in the Point box and then select your desired 

visualized points in Microstation for both ends of the first element and do the 

same for the next element.   

 

3. Click the intersect button and a point will be created at the specified intersection 

between four known points. 

 

 

 Intersection using two known points and a direction from each (bearing-bearing) 

 

1. Open the intersection tool 

and set both types of 

elements to Line.  Also type 

in the point number you 

wish to store.   

 

2. For the first element 

determine the point from 

which you wish to start your 

intersection from.  Then 

determine the direction (Pa 

To Pb).  This is the same 

principal as what was used 

in the Locate Traverse 

section of this manual. 

3. Do the same for the second element and 

then click ok.  This will create an 

intersection at the specified direction 

from each point.  Make sure that you use 

the proper direction of the line so that 

the lines will intersect. 

  

 Intersection between two known points at 

a specified distance (distant-distance) 

 

1. Open the intersection tool and set both 

types of elements to Arc.  Also type in the 

point number you wish to store.   
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2. Select the points you wish to use by clicking on the desired visualized points in 

your Microstation file and type in the distance from each that you wish for them 

to intersect at.  Keep in mind the distances specified need to create an 

intersection.  For example, if the two points are 1000’ apart don’t type in 200’ 

from one and 200’ from another because they will not intersect, there will be a 

minimum of a 600’ gap.   

 

3. Click on the direction qualifier box and determine the direction.  There will be 

three options to choose from, Near Point, Right, or Left.  The Near Point refers to 

a point that the intersection is close to, the Right and Left options need to be 

thought of in the following manner.  If a line were to be drawn from the first point 

to the second point which side of that line is the desired intersection on?  When 

creating a distance-distance intersection there will be two possible intersections 

created so you need to be mindful of which point you want. 

 

CURVE TOOL 

In order to use the curve tools in geopak, the user should have a basic 

knowledge of the different parts of a curve.  Below is a sheet from the 1973 technical 

manual showing the different elements of a curve.  Refer to this sketch with any 

questions on the various parts of a curve. 
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 Store Curve by Endpoints tool 

This curve tool is commonly used when a curve needs to be computed and only 

the endpoints of the curve and one other piece of information about the curve are 

known.  The endpoints are also known as the PC and PT of the curve.  In many cases 

this curve tool is used when a curve is non-tangential.  This just means that the direction 

of the line into and out of the curve does not match the direction of the tangents of the 

curve itself. 

1. Open the tool and enter the curve name 

you wish to store in the ‘Name’ box.   

 

2. Click in the PC Point Number box and 

then click on the visualized point in your 

Microstation file that you wish to have as 

the PC of your curve.  Do the same for the 

PT Point Number.  Keep in mind that if the 

user will be using this curve as an element 

in a chain the points that are identified as 

the PC and PT are very important 

because this will establish the direction of the curve.   

3. Make sure the box under PT Point Number is set to the appropriate curve part.  

In most cases the user will select Radius.  Enter that information into the box. 

4. Select the direction of the curve whether it is clockwise or counterclockwise.  This 

will set which side of the chord the arc will appear on. 

5. Click on Store Curve to complete creating your curve. 

 

 Store Curve by Tangents tool 

To create a tangential curve the user will want to use the Store Curve by 

Tangents Tool.  This tool will use the information surrounding the curve and also 

information about the curve to be created in order to create a curve that flows smoothly 

between line segments. 

1. Open the tool and 

enter the curve 

name you wish to 

store in the Curve 

Name box. 
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2. Under the Back Tangent area select the PC point by clicking in the box under 

PC Point to move the cursor to the box and then click on the desired visualized 

point to make it the PC Point. 

 

3. The Direction Back is another way of saying Back Tangent Direction.  To select 

this direction the user can either type in an azimuth/bearing or they can select 

the two points leading into the curve.  The user will need to be mindful of the 

direction in which the curve is to travel to understand what the Direction Back is.  

This direction back is the azimuth/bearing  from the point before the PC of the 

curve to the PC of the curve. 

 

4. Under the Element area of this tool select the information about the curve you 

would like to use.  This is where you will take a piece of information about the 

curve and enter it here.  In most cases the radius is what is used as this is a 

very important part of a curve.  There are other pieces of information the user 

can enter, but the Radius is most common.  It all depends on what information is 

available about the curve. 

 

5. The Ahead Tangent is the direction of the line that will be coming out of the 

curve at its PT.  There are several options to choose from.  Again, the user will 

need to be mindful of what information is available and what is important when 

creating the curve.   

 

Options for Ahead Tangent 

 

 If perfect tangency is required using the Deflection Angle 

(Same as Delta or Central Angle) is best.  This is the third 

option from the top of the selection set shown to the right.  

To enter the deflection angle the syntax of DDD MM SS 

should be used.   Enter your angle and then click Store 

Curve. 

 

 The Length of the curve is also a common option that is 

used. This is the fifth option from the top of the selection 

list.  If this option is selected it’s important to remember 

that because of how the software does its computing and 

rounding of numbers tangency could be affected.  Enter 

the length of the curve and click Store Curve. 
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 The Chord Length is the other commonly used option.  This is the sixth option 

from the top of the selection list.  If this option is selected it’s also important to 

remember that because of how the software does its computing and rounding of 

numbers tangency could be affected.  Enter the length of the chord and click 

Store Curve. 

Summary 

 

 It’s important to remember that there are several ways to compute a point, line, 

offset point, curve, etc...  The above described tools are ones to help a user of geopak 

compute any of these.  Geopak offers other tools in the Graphical COGO toolbox.  Once 

a user is familiar with these basic tools and has an understanding of the basic drafting 

tools in Microstation he/she will be able to use the Graphical COGO tools with much 

more ease and proficiency.   

 

 

Chapter 4 

LIDAR to DTM  

By Jordan Kurth 

 

 Light Detection and Ranging (LIDAR) is a remote sensing technology, like the 

aerial photos, the data can be used to assist with construction projects.  Instead of 

taking photos, LIDAR uses a laser to scan the surface of the Earth and measures the 

reflected light.  The data gathered is useful for many different groups, ranging from 

agriculture, archaeology, biology/conservation, etc.  For right of way, the data can be 

transformed into contours. 
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Chapter 5 

Map Projections 

 

A map is a graphic representation or scale model of the Earth.  The globe is a three 

dimensional spherical scale model of terrestrial bodies, like the Earth.  Unfortunately 

carrying a globe around to convey geographic information is impractical.  This has been 

a dilemma for map makers, or cartographers, for many years, maybe even 8,000 years. 

 

 

 

 

 

 

 

 

The Fra Mauro map: 

Made around 1450 by the 

Venetian Monk Fra Mauro 

 

 

 

 

 

Map projection is the attempt to portray the surface of the Earth.  Imagine gift wrapping 

a rubber ball.  It takes many folds, cuts, wrinkles to cover the round object with a flat 

piece of paper.  There are three classes of projections:  cylindrical, conical and 

azimuthal.   
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Cylindrical – The most common 

type of projection.  Imagine placing 

the movie screen around the globe 

in a cylinder shape.  The areas 

close to the equator have little 

distortion but as you travel closer 

to the poles, the more distorted the 

map gets. 

 

 

 

 

 

 

 

 

 

 

Conic – It is created by placing 

a cone on a globe.  It’s more 

accurate than the cylindrical. 

 

 

 

 

 

 

 

 

Azimuthal or plane -   
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Distortions occur with all projections. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Video on map projections of the earth: 

https://www.youtube.com/watch?v=X4wgFSHZXBg 

Grid Systems or Coordinate Systems 

A grid system allows the location of a point on a map to be described in a way that is 

meaningful and universally understood.  There are several types of grids used to divide 

the Earth’s surface in the United States:  Geographic, UTM, State Plane and County.   

 

 

 

 

 

https://www.youtube.com/watch?v=X4wgFSHZXBg
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The Geographic Coordinate System uses 

latitudes and longitudes to describe a 

location. 

 

 

 

 

 

Universal Transverse Mercator Geographic Coordinate System (UTM) divides the Earth 

into swaths six degrees in longitude wide.  The first zone begins at the International 

Date Line and numbered from west to east.  Minnesota falls mostly within zone 15. 
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The State Plane Coordinate System (SPCS) 

was developed by the U.S. Coast and 

Geodetic Survey to provide a common 

reference system.  Each state was divided into 

zones and assigned a projection with 

parameters suited to the state’s unique shape. 

Minnesota has three zones, north, central and 

south and uses the Lambert Conformal 

Projection. 

 

 
    
The County Coordinate System is just that; each county has their own coordinate 

system.   

NAD27 Minnesota Project Coordinate System: 

 

For more information about map projection and parameter for MnDOT: 

http://www.dot.state.mn.us/surveying/toolstech/mapproj.html#27MPCS 

http://www.dot.state.mn.us/surveying/toolstech/mapproj.html#27MPCS
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Datums: 

The NGS and NOAA have provided some educational videos that explain datums: 

https://www.youtube.com/watch?v=kXTHaMY3cVk 

The conversions between Datums (from MnDOT surveying tech sheet) 

  

https://www.youtube.com/watch?v=kXTHaMY3cVk
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Appendix A 

Metro Plat Computation Standards 

Created by David Streitz, 2004 

 
 Create 1 gpk file per job using the number to the right of the dash in the S.P. as the job # 

(ex. 2776-31  gpk name would be 031).  Store file in Plats directory above the 
individual plat folders. 

 Gpk element naming conventions: 
Element name   Feature 

Points 
B-Points   DSxxxx   B 

TE-Points   DSTExx   TE 

Comp Points  DS1    COMP 

 Equate B-Point numbers to existing R/W points created by surveys for visualization 
purposes but use original survey numbers for the report and comp map. 

Curves 
New Curves  DSxx01   PLAT 

Curve Segments  DSxxxx-1   PLAT 

Chains 

Plat Boundary  DSxxxB,B1,B2,IB,E  PLAT 

 Use original survey element names when they exist 

  
Land Ties   DSxxxLT1   COMP 

TE    DSxxxTE1   TE 

 Plat Computations Report 

 Use the insert  file command to bring all pertanent gpk output files into 1 Word 
document.  These include all inverses, land ties and closures. 

 File name  Plat Comps Report xx-xxx  
 Plat Computations Map 

 pdf format 

 See graphical standard 

 File name  Plat Comp Map xx-xxx 

 If comps include curve segments, include a label for the original curve that the 
segements were created from 

 Plat Review File 

 Create 1 pdf file from the following individual files: 
1. Scan of the final redlined plat review 
2. Scan of the plat checklist 
3. Scan or electronic version of the areas checklist 
4. Any important correspondence 
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 File name  Plat Review xx-xxx 
 When plat complete create a Finals folder within each plat folder and transfer the following 

files:  comps.pdf, comps.doc, .plt, review.pdf, geopak input files. 
 EDMS 

Documents             EDMS Doc. Type 

Plat Comps Report xx-xxx       PLATBNDY 

Plat Comps Map xx-xxx        PLATBNDY 

Plat Review xx-xxx        PLATRPT 

xx-xxx Breakdown        PLATRPT 

 Section Corner Certs.      
N1/4 1-25-43         CERT_LOC 

SE 1-25-43 

MC E Line 

WC N1/4 1-25-43 

RM N1/4 1-25-43   

 Gpk plat boundary closures 

 Create boundary parcel  make input file  import to a new gpk named cls. 

A. Run closure and save parcel for future changes 
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Appendix B 

WMS and Raster Photo Workflow 

CAES Office Tech Sheet 7/30/2015 

General 
In general, it is desirable to attach any raster imagery or WMS services (XWMS) imagery files to 

an empty DGN file. Then use this DGN file as a reference to other files on a project on an as 

needed basis. In addition a user may want to create a Geospatial PDF to be retained with the 

project. 

Benefits: 

 Uniform imagery across a project. 

 Eliminates rework in setting up or modifying the imagery. 

 Avoids nested imagery attachments, where multiple copies of the same imagery are loaded 
on top of each other. 

 Avoids inadvertently copying out ProjectWise raster references. 

 Easier manipulation of clipping boundaries from reference dialog. 

 Lessens the need to assign the coordinate system to each project file. 

Raster Workflow 
1. Copy a 2D seed DGN file. 

2. Rename the file according to project information (d340814_raster.dgn). 

3. Open the file. 

4. In Raster Manager, attach the imagery file/files. 

5. Save and exit the file/files. 

Use this file as a reference to other project files where needed. You will be able to use the reference tools 
to Clip and Mask the imagery as needed. 

WMS Workflow 
1. Copy a 2D seed DGN file. 

2. Rename the file according to project information (d340814_raster.dgn). 

3. Open the file. 

4. Assign the appropriate county coordinate system to the file. For more information see: 
MS_AssignCoordinateSystems.doc 

5. In Raster Manager, click File > New > WMS… 

6. Select or add the path to the image service. 

7. Select the layer/layers you want to add. 

8. Use the appropriate coordinate system for the imagery depending on where you are in the 
state. The far Western part of the state is EPSG:26914 and the rest of the state is 
EPSG:26915. 

pw://pw8i.ad.dot.state.mn.us:cadp/Documents/TechSheets/MicroStation/MS_AssignCoordinateSystems.doc
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9. Set the image format as image/jpeg for the fastest display if available. 

 

10. Click Add to Map. 

11. Click Save and Attach… 

 



68 
 

12. Save the file to ProjectWise. 

13. Make sure the setting for “Inherit GeoCS from Model” is toggled off. This will reproject the 
imagery into the county coordinate system. 

14. Save and exit the file/files. 

Use this file as a reference to other project files where needed. You will be able to use the reference tools 
to Clip and Mask the imagery as needed.  

Additional Services 
 Some basic WMS services are preloaded in the Microstation WMS directory 

 The address of additional services can typically be found on the web if the information 
exists. 

 Additional WMS services are available here - 
http://mndotgis.dot.state.mn.us/egis12/rest/services/ 

 Click on the service you wish to use, and then select “WMS” at the top of the page. 
Some of these are not in WMS format. 

 Copy and paste the website link into the Microstation WMS window 

 

 

Optional – Create Static PDF Image from WMS service 
Often times a user may want to create a static image of the WMS to be used as a reference and 

retain with the project or because of performance issues. With WMS imagery the speed of the 

raster display depends on a multitude of parameters; network traffic, image quality, service 

speed, etc... Every time a new print is created the information from the WMS must be pulled 

down in the creation of the plot. 

The following steps are an outline of how to create such imagery in a Geospatial PDF for 

reference. 

A Geospatial PDF is one in which the coordinate system is embedded in the file. One obstacle 

is that Geospatial PDF files do not work with county coordinates so the coordinate system of the 

file would have to the same as the WMS service. 

http://mndotgis.dot.state.mn.us/egis12/rest/services/
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1. Create a dgn file with coordinate system of WMS Service (d340814_raster.dgn). 

2. Create/Attach WMS service. 

3. Fence area for desired image. Only use an area for the project limits. Do not encompass a 
entire county. 

4. Use MicroStation Print (File> Print) with a pdf.pltcfg driver file that has geospatial enabled. 
(Example: pw:\\PW8i.ad.dot.state.mn.us:cadp\Documents\TechSheets\MicroStationTS\pdf-
wms.pltcfg) 

A. File> Select Bentley Driver – Choose the pdf.pltcfg 

 Fine tuning of the pltcfg config file would be needed also, such as resolution and 
dpi depending on the imagery. 

 

5. Change Settings for print. 

a. Change the MicroStation print Setting > Preferences to allow paper size editing 
 if not already enabled. 

b. Set the Print to Rasterized – You will want to Change this back afterwards 
 otherwise it may slow your typical print. 

c. Set the scale and the paper size to eliminate any “White space.” 

 

 

6. Click Print.  

 

pw://PW8i.ad.dot.state.mn.us:cadp/Documents/TechSheets/MicroStationTS/pdf-wms.pltcfg
pw://PW8i.ad.dot.state.mn.us:cadp/Documents/TechSheets/MicroStationTS/pdf-wms.pltcfg
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7. Once PDF created, verify that Lat/ Long display by opening the PDF 

A. Use the Edit > Analysis > Geospatial to verify the Lat/Long. 

B. Verify the quality. 

 

8. Attach via raster manager to DGN file. 

Note: The time it takes to create the pdf is directly related to the resolution settings of the pdf.pltcfg.  Do 
not set it too high! 

 

 

 

 

 

 


